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Abstract

Photogrammetry from aerial pictures acquired through micro
Unmanned Aerial Vehicles (UAV), integrated by post-processing is a
promising methodology both in terms of speed of data acquisition,
degree of automation of data processing and cost-effectiveness. The
new UAV-GIS methodology has been developed for three main purpos-
es: i) for a quick measurement of rill erosion at a field scale with the
aim of combining the simplicity of field survey to reliability of results,
at an affordable price; ii) to calibrate the RUSLE model to make it suit-
able for the purposes of the CAP common indicator; iii) to  provide an
easy evaluation tool to Regions and to non-research professionals who
use the very popular ESRI ArcGis software for assessing the effective-
ness of soil conservation measures adopted under CAP and to calibrate
the common indicator ‘soil erosion by water’. High-resolution stereo
photos pairs, acquired close to the soil, are of crucial importance in
order to produce high resolution DEMs to be analysed under GIS. The
GIS methodology consists of the measurement of rill erosion that
occurred in a plot from the total volume of the incisions, regardless of
internal sediment redeposition, based on Plan Curvature analysis and
Focal Statistics analysis, described in detail, as they are the essential
constituents of the new methodology. To determine the effectiveness
and reliability of the new methodology a comparison between rill depth

measured manually on field of 51 rill points and depth measured by
UAV-GIS methodology was done. The best calibration equation was
obtained by using 30 cm radius in the Focal statistics analysis. The lin-
ear regression equation resulted highly significant with R2 =0.87. Two
case studies are presented, solved step by step, in order to help the user
to overcome possible difficulties of interpretation in the application of
the GIS procedure. The first solved exercise concerns a heavily eroded
plot where only one DEM, derived from post erosion UAV photos, was
used to calculate rills erosion. In this case, incisions due to tillage tools
and wheel tracks (false rills) which were present on the soil surface
before soil erosion had occurred were no longer present at flight time,
as they have been fully incorporated (absorbed) by rills. The second
exercise concerns a less rilled plot, where the diachronic analysis of
DEMs was deemed necessary to subtract from the rill volume the false
rill volume which was still present on the soil surface before soil ero-
sion has occurred. In this case rill erosion increased the volume of pre-
existing mechanical incisions that are still distinguishable (with the
naked eye on the field) from the incision forms due to runoff water. A
solved exercise to assess interrill erosion from the calculated value of
rill erosion, according to a previous study of 1989, is also reported. A
comparison between UAV-GIS measured and RUSLE predicted erosion
rates is also reported, which gives a first confirmation of validity of the
new methodology.
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Preface 

Soil erosion by water is one of the most widespread forms of soil
degradation in Europe, largely due to intensification of agriculture on
sloped land. Eurostat (2013) reports that approximately 15% of the
European Union territory (with the exclusion of  Cyprus, Greece and
Malta) is estimated to be affected by medium to high level of soil ero-
sion rate (spanning 3-30 t ha–1 year–1) and 1% of the EU land surface
suffers from extreme erosion (over 30 t ha–1 year–1). Since the mid-
1980s, agri-environmental policies have started been implemented in
all European Union (EU) countries as a response to EU regulations. In
the 1990s the Mac Sharry’s reform consistently integrated environmen-
tal concerns into the Common Agricultural Policy (CAP), followed in
this process by the Fischler’s reform (EU REG.1782/2003), by the
‘Thematic strategy for soil protection’ (EC, 2012) and by the Europe
2020 Strategy (EC, 2010).
In the CAP, environmental issues can be reached on the basis of the

distinction between two main goals: 
i) Ensuring a sustainable way of farming by avoiding environmentally
harmful agricultural activity. In this context farmers, according to
the ‘Polluter-Pays-Principle’, are obliged to respect mandatory
‘Cross-compliance’ rules and GAEC2 standards (forming the ‘refer-
ence level’ or ‘baseline’) and ‘greening’ obligations, for preserving
the environment and the landscape. These commitments are imple-
mented under the first pillar of CAP supported by EAGF (European
Agricultural Guarantee Fund). 

ii) Providing incentives for environmentally beneficial public goods
and services which are of interest to the wider public and society
beyond the mandatory requirements, according to the ‘provider-gets-
principle’ (where farmers are remunerated for voluntarily engaging
in environment-related activities). Incentives to farmers are given
so as to adopt specific agri- environment measures implemented by
Rural Development Programmes (RDP) under the second pillar of
CAP, supported by EAFRD (European Agricultural Fund for Rural
Development). 
In order to be accountable, policy outcomes need to be assessed

against stated objectives. Also the process of integrating environmental
concerns into the Common Agricultural Policy needs regular assess-
ments. In the EU, an elaborated approach towards regular policy evalu-
ation has been established at European, national, or regional
level.Specific agri-environmental indicators are a helpful tool for policy
assessment, as they capture  trends effectively as well as developments
over time. 
The Regulation (EU) No. 808/2014, which codifies the application of

Regulation (EU) No. 1305/2013, entails that for each focus area includ-
ed in the RDP, the related question must be answered in the enhanced
annual implementation reports (AIRs) that will be due in 2017 and
2019, and in the ex-post evaluation report. For the Focus area 4C
(Preventing soil erosion and improving soil management), the evalua-
tion question is: ‘To what extent have RDP interventions supported the
prevention of soil erosion and improvement of soil management?’ To
answer such a question, the appropriate indicator to quantify soil ero-
sion can be found in the list of EU common indicators given by the
European Evaluation Network for Rural development (ENRD, 2013).
The common indicator ‘soil erosion by water’ is defined as the mean
rate of soil loss by water erosion (t ha–1 year–1) as estimated on a
regional scale by the RUSLE model (Renard et al., 1997). 

Aim of the UAV-GIS methodology 

The new UAV-GIS methodology has been developed for three main
purposes: i) for a quick measurement of rill erosion at a field scale with
the aim of combining  the simplicity of field survey to precision of
results, at an affordable price; ii) to calibrate the RUSLE model to make
it suitable for the purposes of the CAP common indicator for the Italian
environment; and iii) to provide a ease tool to technical regional serv-
ices, independent evaluators3 responsible for the evaluation or rural
development plans and non-research professionals  who use the very
popular ESRI ArcGis software. In this regard, the methodology has been
designed to solve specific problems of monitoring the effectiveness of
agronomic actions implemented in Italy within the framework of the
CAP to combat soil erosion. This provides a fast method that allows the
comparison of soil erosion rates between factual and counterfactual
(namely, ‘in application’ versus ‘non-application’ of agronomic actions
dictated by GAEC Cross-compliance Standards and by Agri-environmen-
tal measures of national and/or regional rural development pro-
grammes (RDPs). As already stated, the common indicator ‘soil erosion
by water’ must be estimated under CAP on a regional scale by the
RUSLE model. Anyway, some problem can arise when this model is
applied without any calibration.
RUSLE is a predictive model developed by the USDA-Agricultural

Research Service for use as a conservation planning designed to pre-
dict long-term annual averages of soil loss. This model derives from the
previous model USLE (Wischmeier and Smith, 1978) and is a paramet-
ric equation as follows:

A = R.K.LS.C.P                                                                           (eq. 1)

where 
A = Soil loss in t ha–1 over a period selected for R, usually on a yearly
basis;
R = Rainfall-runoff erosivity factor in MJ mm ha–1hr–1yr–1;
K = Soil erodibility factor in t h MJ–1 mm;
L = Slope length factor (dimensionless);
S = Slope steepness factor (dimensionless);
C = Cover and management factor (dimensionless); 
P = Conservation support practices factor (dimensionless).

The Conservation support practices factor P is the most unpre-
dictable of the RUSLE factors, since site-specific conditions contribute
to great variability in the erosion data, especially when related to
severe storms (Yoder et al., 2001). For this reason, before applying the
RUSLE model at a regional scale, in order to answer the RDP evaluation
question a calibration of the model is needed to suit this model to local
conditions (Hammad et al., 2004), especially when conservation prac-
tices are complex. To calibrate the RUSLE model, in particular to apply
it to evaluate the effectiveness of CAP agri-environmental actions
implemented by farmers, it is necessary to compare the predicted val-
ues against measured values in field, on a set of  different case-study
sites. 
In the MO.NA.CO. project (see first page of this paper) the effective-

ness of the GAEC cross-compliance standard ‘temporary ditches to con-
trol erosion on sloping land’ was determined in different  farms by
using the new UAV-GIS methodology and a comparison between RUSLE
prediction vs. observed ones was done. The results are presented in
another paper of this special issue of the Italian Journal of Agronomy
(Bazzoffi et al., 2015). 
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3Established under article 84(4) of Council Regulation 1698/2005.

2The Good Agricultural and Environmental Conditions (GAECs) are defined in the framework of the so-
called Cross compliance. In order to ensure that all agricultural land is maintained in good agricultural
and environmental conditions, member States shall define minimum requirements on the basis of Annex
II of Council Regulation (EC) No 1306/2013.
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UAV photogrammetry 

Among the techniques for measuring rill and interrill erosion
(Douglas, 2001), photogrammetry from aerial pictures acquired
through micro Unmanned Aerial Vehicles (UAV), integrated by post
processing, is a  promising methodology in terms of speed of data
acquisition, degree of automation of data processing and cost-effective-
ness.
The main advantage of micro drone UAV  photogrammetry is the pos-

sibility of  generation, at moderate costs, of high resolution Digital
Elevation Models (DEMs) from stereo images taken near the soil sur-
face by a high resolution camera. Furthermore, since the equipment
(multirotor helicopter  or micro aerial vehicle equipped with inertial
measurement unit  and GPS) is easy to acquire and manage, the user
can schedule the flight plan autonomously and quickly decide the date
of the flight when sunlight, weather and surface condition of the soil
are the more favourable to produce high quality pictures suitable for
measuring the studied variable and to generate a high quality DEM. On
the contrary, the major limitation of this methodology consists of
obtaining valid aerial pictures of the terrain surface when: i) vegeta-
tion and crop residues cover the soil; and ii) when the movement of
shadows due to the lapsed time between adjacent aerial photo strips,
changes the scene with consequent susceptibility to outliers as a reac-
tion to shadow movement. 
The former problem could be solved by vegetation filtering by near

infrared images or by using the laser scanner technology LIDAR (Light
detection and ranging) now transportable by multirotor drones and
other unmanned vehicles. In any event, the effectiveness of LIDAR to
produce a high quality DEM when the soil is covered by vegetation and
plant residues depends on the quantity and distribution of the bare soil
surface that still remains reachable by the laser beam. The problem of
scene change due to shadow movement can be partly solved by per-
forming, if possible, the UAV surveys when the sky is overcast with
scattered light. Generally, a compromise has to be found between high
resolution (fly at low altitude with lengthening of the time between
photographic strips) and the susceptibility to outliers as a reaction to
shadow movement. In any case it is recommended to place a high num-
ber of GCPs (Ground Control Points)on the soil surface, although it is
time consuming (Rock et al., 2011). 
It appears to be intuitive to measure soil erosion  by a simple

diachronic  comparison of two DEM’s representing the same surface
respectively before and after soil erosion has occurred, on the assump-
tion that the elevation of the soil surface would change  only due to soil
erosion. This assumption however is not always true and cannot be
easily verified. A DEM modification can be determined also by other
processes, with consequent masking effect of the elevation change due
to erosion, in particular: i) by post-tillage consolidation of soil, which
leads to a progressive increase of soil bulk density and consequently a
general (and non-predictable in time and space) decrease of elevation
of the surface; ii) by mass movements, as creeping and landslide; iii)
by soil deformation due to shrink-swell of clay minerals in relation to
soil moisture changes (Bronswijk, 1991; Brake et al., 2103). 
Recently, Eltner et al. (2014) quantified  rill and interrill erosion

processes over a 600 m2 field plot areas by using multi-temporal DEMs
obtained by using a UAV (octocopter equipped with high resolution
camera) and a semi-automatic post-processing methodology to extract
rills. This procedure  entails a previous smoothing of the soil surface
through a filter before applying the Canny operator (Canny, 1986) to
extract the rill wall position. Afterwards, for each rill,  width, depth,
cross-section area  of rills were automatically calculated for cross-sec-
tions with a sampling distance of 1 cm. From these data the volume of
the incisions over the soil surface was calculated. Nevertheless, this
methodology is not easy to apply by no research users.

Materials and methods

Drone and camera description
The survey of rill erosion on the study areas was performed by using

a mini electric UAV Octocopter, model Falcon 8 by Astec (Ascending
technologies) as shown in Figure 1. The system is composed of an air-
plane with 8 electrical rotors in vertical takeoff and landing and a sys-
tem of remote pilotage MGS (Mobile Ground Station). A control unit
on-board of the flying vehicle manages the flight by using data from
sensors (GPS, gyroscopes for attitude control and a barometer for the
elevation relating to the ground) and interact with the mobile ground
station to drive the vehicle over the planned waypoints. A proprietary
Asctech  software  was used to program and manage the flight by con-
necting a laptop to the MGS. By remote control unmanned Falcon can
fly autonomously, following pre-programmed paths and doing zenital
shots at each waypoint, or the flight can be completely controlled by the
user, assisted only by the stabilizer trim. The camera carried by Falcon
8 was a  SONY NEX-5 (14.2 megapixel APS-C sensor, tilting of +/- 90°)
actively compensated in pitch and roll axis. The Falcon 8 system comes
with a ground remote control to operate the drone  in conjunction with
a PC that contains the flight plan.

Ground Control Points and topographic survey
Markers (Ground Control or Reference Points) are used to optimize

camera positions and orientation data, which allows for better DEM
reconstruction results. To generate accurate orthophotos at least 10 –
15 ground control points (GCP) should be distributed evenly within the
area of interest to be processed. In any event, by following the above-
cited  suggestion of  Rock et al. 2011, it was preferred to place on the
soil surface a high number of GCPs in order to achieve the iper- deter-
mination  of stereo pairs for  better accuracy. 
GCP targets consisted of plastic sheets panels (50 x 50 cm). On each

panel, four square, black and white sectors, were drawn in a alternate
cross pattern. At the centre of the panel a small hole was performed
(drilled) to allow the exact positioning of the topographic pole during the
GPS survey.  The placement of GCPs was preceded by the definition of a
square grid of points, over the georeferenced GoogleEarth image of the
survey field, where to place evenly spaced targets. On field, with the help
of a handheld rough GPS, GCPs targets were placed on the predefined
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Figure 1. Falcon 8 Octocopter, and remote control station. In the
background, a field rilled by soil erosion in one of the study areas
of the MO.NA.CO. project.
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position of points. After placing the GCP markers their exact position was
acquired with a topographic field survey by using a Leica GPS 1200  sys-
tem (double-frequency, GPS/GLONASS) in RTK mode. It is known that
accuracy of position and height of point measurement are dependent on
many factors including number of satellites, geometry, observation time,
ephemeris accuracy, ionosphere conditions, multipath etc.. RTK accura-
cies for the Leica GPS 1200  system stated by the manufacturer are:
Horizontal (XY coordinates) ±10mm, Height (Elevation) ±20mm.
GLONASS can increase accuracy by up to 30% relative to GPS only.
Nevertheless, after processing 654 survey points through Leica Geo
Office software (LGO), the statistical analysis of quality results revealed
a better performance as opposed to the manufacturer’s tolerance values.
In fact, horizontal accuracy resulted in ±0.869 mm for the XY coordinates
and in ± 1.391 mm for elevation. Probably this good performance was
due to very small distances between the base and rover antennas (max-
imum distance detected 234.2 m). 
For this kind of survey, unless there are special reasons, it is not

strictly necessary to transform the local XYZ coordinates into the
National Geodetic Network coordinate system. This way it is possible to
save time and be operational shortly upon arriving at the site to be sur-
veyed. The only care needed in order to repeat the survey in the future,
if it becomes necessary, is to place the GPS base in correspondence of
a permanent landmark located near the field to be measured, making it
possible to reposition the base station on the same point and assign to
it the same coordinate values detected in the previous survey. 
In the present work GCP markers were georeferred by using the

native  GPS receiver coordinates, in the UTM-WGS84 geodetic system
(ellissoidic elevations). In the video recognition of GCPs (post process-
ing phase), for each marker the XYZ coordinates were assigned to the
position of the hole in the centre of the panel.

UAV image post-processing and DEM reconstruction
Many image matching and surface reconstruction methods have

been developed in recent years. On one hand they implement well-
established techniques like Least Square Matching (Grün, 1985), and
on the other innovative global and semi-global matching methods.
Gross (2015) compared geometric accuracy, visual quality, ease of use
and cost of three most popular image stitching software packages to
create orthomosaics from the individual images: Photoscan Pro, Pix4D
Pro Mapper and Microsoft Image Composite Editor for creating ortho-
mosaics. Results suggested that Photoscan Pro and Pix4D Pro Mapper
produced the best geometric accuracy, as measured by the root mean
square error (RMSE) of real XY coordinates measured in field of a
number of Ground Control Points compared to image derived coordi-
nates. In addition, Photoscan Pro is significantly cheaper and ease to
use than the other softwares. 
From these considerations and with the goal of providing a low-cost

methodology for measurement of  rill erosion we used the Agisoft
PhotoScan Pro commercial software, developed byAgisoft LLC company.
Agisoft PhotoScan Pro has a very simple graphical user interface and it
is able to perform both the orientation and the following dense stereo
matching steps using a multi-image approach. Initially the software
defines the images orientation and refines calibration camera param-
eters (the geometry of the images sequence allows to estimate a set of
interior orientation parameters for each camera, should these have not
been previously assigned); subsequently, it proceeds to the DEM gen-
eration. PhotoScan does not display the statistical results of the pho-
togrammetric processing, for it is a sort of ‘black-box’ software. All the
photogrammetric process is performed with a high level of automation
and the user can decide the desired cloud density points  density and
the 3D modelling quality. The workflow is therefore extremely intuitive,
being an ideal solution for less experienced users. Due to commercial
reasons very little information about the algorithms used is available:
some details can be recovered from the Photoscan User forum

(http://www.agisoft.com/forum/index.php). Except for a ‘Fast’ recon-
struction method, selectable by the user before the image matching
process starts, that use a multi-view approach, the depth map calcula-
tion is performed pair-wise (probably using all the possible overlapping
image pairs) and merging all the results into a single, final, 3D model.
In fact, a multi-base line matching extension is more resilient against
occlusion-detection and wrong matches, effecting the fusion of dispar-
ity of information given by all the match images and producing
smoother results. 
Table 1 shows the survey data produced by Agisoft PhotoScan Pro

(post-processing reports) of the plots investigated in the framework of
the MONACO project.  This table is intended to help the user to repro-
duce the same experimental conditions to get similar results of the
example exercises reported later in the text, by using the mean values
of the 14 reports.  It is important to state that, in the same table 1, the
mean flying altitude has been calculated ex-post by Agisoft PhotoScan
Pro, while in the field the UAV altitude was set equal to 30 m for all the
surveys performed. This value is the altitude of the first waypoint of the
AUV survey, starting from the most upstream part of the plot to be sur-
veyed. The vehicle flies horizontally, so that the distance from the
ground increases as it proceeds from upstream to downstream. For this
reason the mean flying altitude calculated ex-post is always higher
than the elevation imposed as initial flying parameter.

Accuracy of DEM elevations 
The accuracy of elevation of the raster produced through the Falcon

8-PhotoScan system was determined  by the statistical comparison
(Student’s t-test) of the mean elevation of 540 points detected respec-
tively: i) by GPS field survey done on the occasion of one of  UAV flights,
and ii) by the Spatial Analyst tool ‘Extract values to points’ of ArcGis
10.0, where the input point feature defining the locations from which
to extract the raster cell values is the shp-file contains the GPS-survey
coordinates of the 540 points and the raster dataset whose values were
extracted was the DEM produced by photoscan-pro software.
The results of this analysis are shown in Table 2. The mean differ-

ence, although statistically significant (P<0.01), resulted very limited
(-0.52 cm) and the DEM produced by photoscan-pro software, in our
experimental conditions can be considered effective for detecting rill
incisions.

The new UAV-GIS methodology

To measure rill erosion occurred in a plot, regardless to sediment
redeposition, the total volume of the incisions must be determined. To
achieve this result, we assume that a channel cell has a negative plan
curvature (Rana, 2006) and a non-channel cell has a zero or positive
plan curvature. This way it is possible to find rill areas through curva-
ture analysis. The methodology is based on two main analyses per-
formed in ESri ArcGis 10.0 environment:
i) Plan Curvature analysis; 
ii) Focal Statistics analysis. 
In agricultural sloped land rills mainly develop on tractor wheel

tracks and on linear soil depressions left by tillage. Thus, when soil ero-
sion is slight, it would be impossible, through plan curvature analysis,
to distinguish which part of a rill has been excavated by runoff water or
is a residue of an incision or a track made respectively by tillage tools
or wheel tractor passes. The optimal way to proceed in order to over-
come this problem is to perform two UAV photo surveys, respectively
before and after the rill has formed, then to apply the methodology by
using the same calculation parameters on both DEMs and subtract the
incision volume of DEM before-rill formation (false rill incisions due to
tillage tools) from the after-rill volume of incisions (true rill). In any
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[page 4]                                                    [Italian Journal of Agronomy 2015; 10(s1):708]                                                                 

Non
 co

mmerc
ial

 us
e o

nly



event, diachronic analysis of multiple consecutive DEMs can be used to
evaluate the increase of rill erosion in consecutive observation periods.
When rill erosion is sufficiently pronounced to cancel false rills, so that
their influence on rill erosion calculation can be considered negligible,
the UAV-GIS methodology can be applied on the after-rill DEM only. The
proposed UAV-GIS methodology is not intended for the measurement of
interrill erosion (sheet erosion) because this process does not deter-
mine surfaces affected by negative plan curvature. Interrill erosion can
be estimated from the calculated value of rill erosion, according to
McCool et al. (1989). A solved exercise to assess interrill erosion is
reported later in the text.
Two case study are presented, solved step by step, in order to help the

user to overcome possible difficulties of interpretation in the applica-
tion of the GIS procedure. The first solved exercise concerns a heavily
eroded plot where only one DEM was used to calculate rill erosion. The
second exercise has as its object that of a not heavily rilled plot where
the diachronic analysis of DEMs, described above, was considered nec-
essary to get rid of false rill influence on soil erosion measurement. In
this case rill erosion increased the volume of pre-existing mechanical
incisions which are still distinguishable (by the naked eye on field)
from the incision-forms due to runoff water. Plan curvature analysis
and Focal Statistics analysis are described in detail, as they are the
essential constituents of the new methodology. The comparison
between UAV-GIS measured and RUSLE predicted erosion rates is also
reported.

Plan Curvature Analysis to identify rills
Plan Curvature Analysis of DEM allows us to identify the cells of the

DEM that belong to rill areas. As reported by Kimerling et al. (2011),
Planform Curvature (commonly called plan curvature) is  the second

derivative of the surface, or the slope-of-the-slope,  perpendicular to the
direction of the maximum slope and reveals the convergence and diver-
gence of flow across the surface (Figure 2). Convex cells have positive
value of Plan curvature and the soil surface is sidewardly convex at that
cell. On the contrary, concave cells have positive values and the surface
is sidewardly concave at that cell. A value of zero indicates that the sur-
face is flat. By performing the Curvature analysis of the DEM, the
resulting Plan curvature raster includes negative (concavities) and
positive (convexities) values. The user must decide the  proper  nega-
tive threshold value above which the raster values do not identify rill
forms. In fact, not all negative Plan curvature cells are ‘organized’ in
such a way to define a rill. Especially when a DEM has a very small cell
size (produced by post processing low-altitude stereo photos) detail is
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Table 1. Survey data produced as post-processing reports by Agisoft PhotoScan Pro.

Agisoft Photo                    Coverage  Images  Images   Ground Control   Mean flying  GCP density        Photomosaic      DEM resolution
Scan Pro Reports                 (ha)          (n)       (n/ha)    Points GCP (n)   altitude (m)   (n.GCP/ha)   resolution  (m/pix)        (m/pix)

Report 1                                             1.074               56             52.14                       27                            42.80                    25.15                          0.01009                            0.0486
Report 2                                             8.892              321            36.10                       61                            44.51                     6.86                           0.01137                            0.0257
Report 3                                             1.165               80             68.67                       26                            40.53                    22.31                          0.00916                            0.0463
Report 4                                             1.699              103            60.62                       31                            49.97                    18.25                          0.01132                            0.0572
Report 5                                             1.056               51             48.30                       27                            45.74                    25.57                          0.01161                            0.0538
Report 6                                             1.074               56             52.14                       25                            42.15                    23.27                          0.01004                            0.0487
Report 7                                             1.645               98             59.57                       39                            47.47                    23.71                          0.01163                            0.0550
Report 8                                             1.027               25             24.34                       12                            47.75                    11.69                          0.01276                            0.0555
Report 9                                             1.764               72             40.82                       29                            48.86                    16.44                          0.01194                            0.0567
Report 10                                           3.704               93             25.11                       22                            41.97                     5.94                           0.01047                            0.0479
Report 11                                           1.637               36             21.99                       66                            40.26                    40.31                          0.01085                            0.0425
Report 12                                           0.960               66             68.75                       66                            55.96                    68.72                          0.01303                            0.0279
Report 13                                           1.453               77             52.99                       69                            44.51                    47.49                          0.01143                            0.0257
Report 14                                           0.234               13             55.56                       23                            38.90                    98.17                          0.01115                            0.0115
Mean                                                  1.956            81.929         47.65                    37.36                         45.10                    30.99                            0.011                               0.043

Standard deviation                          2.140            73.779         15.74                    19.41                         4.610                    25.58                            0.001                              0.0145
Conf. (± 95%)                                  1.531             52.78            9.09                      13.9                           3.30                     18.30                          0.00075                            0.0104

Table 2. Comparison of raster value elevations versus field-survey values detected by geodetic GPS.

                        Mean elevation         SD               N               Diff.           SD diff.                t               df                  p                 P Levene

GPS-survey                    246.5474                 4.107308              540                
-0.00525             0.039758                -3.06818            539               0.0023**                     0.952

Raster value                  246.5526                 4.116980              540
                                                                                                                                                                                              

Figure 2.  Plan curvature is perpendicular to the slope and affects
the convergence and divergence of flow across the surface (modi-
fied from Kimerling et al., 2011). Rills are characterized by neg-
ative Plan curve values.
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so fine that a large number of sparse negative cells generate confusion
and the image of the Plan Curvature raster is not easily interpretable.
The choice of the negative threshold value to identify rills can be per-
formed by using in turn different thresholds followed by the  close-up
observation of the negative curvature cells overlapped both to the
orthophoto and to different hillshade rasters derived from DEM (by
using different azimuth and altitudes). The observation of the flow
accumulation raster can also help; observing the flow accumulation
raster can also be of assistance. A proper ‘natural’ criterion to decide if
the selected threshold is effective to highlight the majority of rills is
that of observing the convergence of micro-rills into major rills. A fee-
ble incision defined by a negative plan curvature threshold can be con-
sidered to be a rill when it is surrounded by other similar forms that
converge all together in a larger and well defined rill.

Anyway, it is evident that the choice of a threshold could determine the
exclusion from calculation of some very small rills. In Figure 3 a small
portion of  the orthophoto mosaic of the rilled plot analysed in exercise 1
is reported. In Figure 4  an example of definition of the Plan Curvature
threshold for a close up view of the same piece of land is reported. 

Focal Statistics to determine rill depth
After Plan Curvature Analysis, Focal Statistics analysis must be per-

formed. This analysis calculates for each input cell of the elevation
raster (DEM) a statistic parameter of the values within a neighbouring
form around it. In our procedure we determine, for each rill cell, the
Maximum value of elevation encountered among the DEM pixels
belonging to a neighbouring circle surrounding the cell. For each rill
point the circular neighbouring form is intended to calculate the differ-
ence between the elevation of the rill rim and the elevation of the point.
This difference is assumed as the depth of the rill in the specific point
position. To better explain the principle of operation of the analysis we
show in Figure 5 a typical manual field survey of the depth of a rill in a
given position. In the figure, the reference bar is placed between the
two rill rims and defines the mean elevation between the two rims. The
tape measurement of the difference of elevation between the bar and
the rill surface is the rill depth in that position. With the use of Focal
Statistics by circles we intend to reproduce in an automated manner a
similar mode of operation, with some simplification and assumptions
as shown in Figure 6. The circle around a given point position inside a
rill intercepts a number of cells of the elevation raster (DEM). The
maximum elevation found by Focal Statistics in the neighbouring circle
is assumed as the elevation of the rill rim. By subtracting the elevation
of rill point from the rill rim elevation  the depth of rill is determined in
the same rill point position. In the text which follows this analysis is
called ‘FocalDiff’ analysis. 

                                Article

Figure 3. Orthophoto of a portion of a rilled surface (taken from
the plot analysed in exercise 1).

Figure 4. PlanCurv cells ≤ -26.4368 (curvature threshold cho-
sen). This value was considered the best compromise to detect
most of the rills. Microrills are represented in blue. Yellow arrows
show the convergence of microrill into major rills. PlanCurve val-
ues >-26.4368 did not evidence incision coherent with runoff
dynamics and were not represented (nc).

Figure 5. Typical field survey of a rill depth in a given rill point
position. The horizontal bar defines the rim elevation.
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Respect to manual operating mode the reference bar is simplified by
a horizontal segment which connects the rim point having the maxi-
mum elevation  to the centre of circle  (the centre corresponds to the
projection of the rill point on the circle). Different from the manual
positioning of the bar, the segment do not connect the two opposite
rims perpendicularly to them. Another simplification is that the eleva-
tion of one rim only is considered instead of interpolating between the
two elevations of opposing rims. In Figure 7 it is shown a 30 cm circle
with the elevation value of a rill point in the centre of the circle and the
maximum value (rill rim elevation) detected through Focal Statistics.
The length of the radius of the circle is of crucial importance. In fact,
for each rill point, the neighbouring circle must be large enough to
intercept an area beyond at least one of the rill rim. At the same time,
the circle must be sufficiently small not to intercept a too large area
beyond the rim. Too large of a circle would lead to a negative repercus-
sion on the calculation of the rill depth, which could result as increased
in respect to reality by the influence of the local slope gradient.
The Plan curvature value associated to each rill point helps the user

in the choice of the proper radius length to be used. This can be easily
explained by the example shown in Figure 8, regarding a portion of the
plot analysed in exercise n.1. In this figure rill points have been over-
lapped to the orthophoto. Points were separated in 3 groups of different
colours according to different ranges of Plan curvatures values. The yel-
low group of points, with plan curvature values spanning -60 -
26.436832, is able to satisfactorily intercept very small rills. The same
group includes rill points of large rills which are very close to rill rims.
For these points, we decided to consider the depths calculated by the 15
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Figure 6. Example of a circular buffer around a given rill point.
The maximum elevation found in the buffer is assumed as the rill
rim elevation.

Figure 7. Representation of a 30-cm neighbouring circle around
a rill point ‘P’ (with elevation 88.31 m asl). The Focal statistics
analysis detected the maximum elevation value 88.38 m (asl)
inside the circle (position ‘M’ in the figure). This value is
assumed as the rim elevation. The elevation difference M minus
P is the depth of rill in the P position.

Figure 9. Regressions of UAV-GIS rill depths (obtained by using
30-cm radius in Focal Stats. ) vs. in field measured depths.

Figure 8. The Plan curvature value associated to each rill point
allows the user the choice of the proper radius length to be used
to calculate rill depth. Non
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cm radius as the most appropriate. In fact the rim is very close to these
rill points. The magenta group of points, having plan curvature values
spanning -610 -125, is able to intercept rill points in the deepest posi-
tion of large rills. For these points, we decided to consider the depths
calculated by the 30 cm radius as these points are the most distant from
the rill rims.The cyan group of points, with plan curvature values span-
ning -125 -60, includes rill points in between the two previous cate-
gories, therefore we decided to consider the depths calculated by the 25
cm radius.    
This operation is particularly needed when on the rilled surface a

variety of wide-to-narrow rills are present. If rills are roughly one-
dimensional only a radius length can be selected. Should the study plot
be differentiable into sub-zones of prevailing rill widths (e.g., very small
rills uphill, very large rills or gullies downhill ) the analysis can be per-
formed separately for each of them, by applying different radius lengths
of neighbouring circles in relation to the prevailing rill dimension.
Then sum up the zone results. However, for the two plots of exercise 1
and 2 reported later in text, we have not deemed it necessary to carry
out the analysis by sub-zones. Total volume of rill erosion (m3) can be
calculated through the simple formula as follows:

V =  ∑n
1 A . H                                                                                 (eq. 2)

where:
n= number of groups of rill points according to different ranges of Plan
curvatures values; 
A= total area of rill cells of DEM (m2) in each group;  
H= mean depth (m) of rill points in each group.

The total area of rill (A) in each group  is calculated  by multiplying
the number of DEM cells (or points) belonging to rills by the cell area.
Mean depth (H) of rill points in each group is the mean value of differ-
ences of rim elevation minus rill point elevation, as determined
through Focal Statistics analysis. Total rill erosion as weight (t) in the
study plot can be calculated by multiplying the sum of rill volumes (m3)
of groups by soil bulk density at AUV-survey time (t m–3). Specific rill
erosion (t/ha) is obtained by dividing  the total rill erosion (t) by the
plot are (ha). Bulk density of soil must be determined by core-method
survey in field (mean value of samples taken close to rill rims, repre-
sentative of the entire plot under study).

Calibration of the UAV-GIS methodology 

To determine the effectiveness and reliability of the new methodolo-
gy a comparison between rill depth measured in field and depth meas-
ured by UAV-GIS analysis was done. Depths of 51 rill points were meas-
ured in the field by hand through horizontal bar and a metal rule
(Figure 5) and georeferred by the use of RTK-GPS. Within a single rill
we did not measure more than a single point.  Where points were meas-
ured is a heavily-rilled field (18.6 ha) at Tor Mancina (Rome) which
includes the plot in exercise n.1 reported below. Measurements in field
were made simultaneously to the UAV-GIS survey. In Table 3 the results
of five linear regressions are shown, according to 5 different radius
size of the neighbourhood circle used in  UAV-GIS analyses.

                                Article

Table 4. Agreement between infield measured depths, grouped by ranges, and UAV-GIS depths obtained by using neighbouring circles
of different radii.

Rill depth range (cm)             Method                                                   Mean depth (cm)                        Mean separation (Duncan test)

0-5                                                            Field survey                                                                           3.39                                                                                A
                                                                 UAV-GIS 10 cm radius                                                         3.43                                                                                A
6-10                                                          Field survey                                                                           8.21                                                                                B
                                                                 UAV-GIS 30 cm radius                                                         8.21                                                                                B
11-15                                                       Field survey                                                                          13.33                                                                               C
                                                                 UAV-GIS 30 cm radius                                                        10.39                                                                               C
16-20                                                       Field survey                                                                          18.60                                                                               D
                                                                 UAV-GIS 30 cm radius                                                        14.97                                                                               D
21-25                                                       Field survey                                                                          23.79                                                                               E
                                                                 UAV-GIS 30 cm radius                                                        20.24                                                                               E
26-30                                                       Field survey                                                                          27.13                                                                               F
                                                                 UAV-GIS 30 cm radius                                                        23.24                                                                               F
31-35                                                       Field survey                                                                          35.17                                                                               G
                                                                 UAV-GIS 30 cm radius                                                        30.22                                                                               G
36-70                                                       Field survey                                                                          60.50                                                                               H
                                                                 UAV-GIS 30 cm radius                                                        58.44                                                                               H

Table 3. Regressions of UAV-GIS rill depths vs. in field measured depths.

Eq.             Focal Statistic Radius cm          Regression R2            F(1.49)       P-level Regress                 B coefficients                St.Err.Est.
                                                                                                                                                                 Intercept               X                       

1                                               10                                                 0.837                            251.99                     0.000000                        -0.1977                   0.6047                      5.28
2                                               15                                                 0.852                            282.55                     0.000000                         0.3437                    0.6415                      5.03
3                                               20                                                 0.867                            318.91                     0.000000                         0.8815                    0.6792                      4.77
4                                               25                                                 0.871                            331.22                     0.000000                         1.3949                    0.7349                      4.70
5                                               30                                                 0.873                            336.72                     0.000000                         1.9886                    0.7594                      4.67
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The 5 Regression equations are as follows:

y = UGdepth 
. X + Intercept                                                           (eq. 3)

where:
UGdepth= rill depth (cm) calculated by UAV-GIS analysis;  
X and intercept coefficients are reported in Table 3.
All equations resulted highly significant with very high R2 coeffi-

cients. The best is equation n. 5 (Figure 9), which was obtained
through UAV-GIS depth values derived by using 30 radius in Focal sta-
tistics. Table 4 shows the agreement between infield measured depths,
grouped by ranges, and UAV-GIS depths obtained by using neighbour-
ing circles of different radius. In the same table only the best agree-
ment are reported, while worst mean depths obtained by using all other
radius lengths were omitted. It is apparent that 10-cm radius was the
best length only for the 0-5 cm rill depth range. For all other ranges of
rill depths the best radius length resulted 30 cm. Table 5 shows the sep-
aration by Duncan test of mean rill depths by different radius length.
In general, from results it can be said that  the UAV-GIS methodolo-

gy can be used to detect rill depth, taking care to use the appropriate
radius length in the Focal statistics analysis.

Step by step description of ESRI ARCGIS pro-
cedure for detecting rill erosion 

Note: File names are only examples. Full Path for folders and files are
omitted.

EXERCISE N.1 (Tor Mancina, Rome)
Severely eroded field (Figure 10). Only one DEM (after erosion)

analysed.

Site description
WGS84 Coordinates of plot centroid: N 42° 05’ 41.70’;  E 12° 37’

58.29’. 
Type: Basin 
Area: 1.5776 ha
Mean Slope: 15.4 % 
Maximum length along the slope gradient: 136.1 m
Geology: Pedogenized stratified volcanic tuffs with lapilli, cinerites

and Pleistocene leucitic scorias. 
Soil classification: Typic Argixeroll (Soil Survey Staff, 2014), Clay

loam texture (USDA, 2015). 
Grain size distribution: Total Sand 39.3%, Total Silt 30.0%, Clay

30.7%, O.M. 1.61%.
Bulk density at UAV survey time: 1.247 t/ m3

UAV-Survey conditions and DEM resolution
Mean flying altitude (m): 41.97 
GCP spacing: on a square grid 40x40 m
Photomosaic resolution  (m/pix): 0.01047
DEM resolution (m/pix): 0.0479437
In Figure 11 the orthomosaic of the study plot is reported

STEP 1: extract DEM by plot mask
Extract the portion of DEM corresponding to the plot on which to

measure rill erosion, by using the shpfile of the plot polygon as feature
mask data. In Figure 12 the shadowed DEM is shown.

ArcToolbox: Spatial Analyst Tools > Extraction > Extract by Mask
Input raster: DEM
Input mask data: Plot Polygon
Output: PlotDEM

STEP 2: DEM smoothing
Perform a smoothing (Low pass) on the plot DEM. This filter trav-

erses a low pass 3-by-3 filter over the raster by calculating the average
(mean) value for each 3 x 3 neighborhood.

ArcToolbox: Spatial Analyst Tools > Neighborhood > Filter
Input raster: PlotDEM
Output raster: Filter_PlotDEM
Filter type: LOW
Ignore NoData in calculation: box flagged

STEP 3: Planar Curvature
Produce the Plan curvature raster of PlotDEM
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Table 5. Separation by Duncan test of mean rill depths by different radius lengths used in UAV-GIS analysis. 

Method                                        Mean rill depth                                        1                                      2                                               3

UAV-GIS 10 cm radius                                         9.80                                                             ****                                                                                                              
UAV-GIS 15 cm radius                                        10.95                                                            ****                                          ****                                                          
UAV-GIS 20 cm radius                                        12.12                                                            ****                                          ****                                                          
UAV-GIS 25 cm radius                                        13.55                                                            ****                                          ****                                                     ****
UAV-GIS 30 cm radius                                        14.55                                                                                                                ****                                                     ****
Field survey                                                          16.54                                                                                                                                                                               ****

Figure 10. In the study plot at Tor Mancina the surface is charac-
terised by heavy soil erosion. 
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ArcToolbox: Spatial Analyst Tools > Surface > Curvature
Input raster: PlotDEM
Output curvature raster: any name (this raster is not required in

subsequent analyses)
Z factor: 1
Output profile curve raster: any name (this raster is not required in

subsequent analyses)
Output plan curve raster: PlCu_Plot 
Filter type: LOW
Ignore NoData in calculation: box flagged

STEP 4: Planar-Curvature threshold selection to identify rills
This step has been explained in the chapter: ‘Plan curvature Analysis

to identify rills’.
Figure 13 shows the result of the rill extraction. 
Output: TresholdValue

STEP 5: Raster calculator (to select pixels belonging to rills)
The selected DEM cell belonging to rills, as detected through the pre-

vious PlanCurv analysis, are extracted from DEM and converted into a
raster.
Through the Map Algebra tool the value 1 is assigned to rill cells,

while ‘Null’ (no data) is assigned to no-rill cell.  The output raster is
used in the following step as ‘multiplier raster’ (Figure 14).

ArcToolbox: Spatial Analyst Tools > Map Algebra > Raster Calculator
Tools: Conditional > Con
Expression: Con(‘PlCu_Plot’, ‘PlCu_Plot’/‘PlCu_Plot’,’’,’VALUE ≤

Threshold value’)
Thershod Value: User choice (in our exercise the selected value was

-26.4368)
Output raster: PlanCurvRill

STEP 6: Assigning the elevation value to pixels belonging to rills
The raster of elevation values for rill cells only is obtained by multi-

plying the DEM by the ‘multiplier  raster’ of Step 5. Where the cells
value of this raster is 1 the result of multiplication is equal to the DEM
value. On <null> cells no elevation value is assigned to the output
raster and <null> result is assigned to cells.

ArcToolbox: Spatial Analyst Tools > Map Algebra > Raster Calculator
Expression: ‘PlotDEM’ * ‘PlanCurvRill’
Output raster: Rill_Elev

STEP 7: Conversion of pixels belonging to rills into a Point shpfile
The raster with elevation values on rill cells is now converted into a

point shpfile.
The resulting table is reported as example in Figure 15. The visual

representation of rill points of the shpfile is shown in Figure 16.

ArcToolbox: Spatial Analyst Tools > Conversion Tools > From Raster
> Raster to Point
Input raster: Rill_Elev
Field: Value
Output point features: Rill_Elev_Points

STEP 8: Focal Statistics on DEM
Focal Statistics calculates for each input cell location of DEM a

selected statistic parameter of the values within a specified neighbour-
hood around it. In this analysis the  maximum value of DEM within a
neighborhood circle around each rill cell is determined. 
This analysis must be repeated several times according to the num-

ber of different radius sizes selected by the user. We performed six
analyses for the following radius sizes: 10 cm, 15 cm, 20 cm, 25 cm, 30

                                Article

Figure 11. The plot at Tor Mancina of the example exercise n. 1. 

Figure 12. The shadow of DEM shows that rills started develop-
ing along tractor wheel tracks and other linear soil depressions
left by tillage.  

Figure 13. The result of rill extraction by selecting the appropri-
ate threshold of Plan curvature value (major rills evidenced in
red, small rill in blue). 
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cm. The maximum radius size was  30 cm because the maximum rill
width observed on the orthophoto was about 50 cm.

ArcToolbox: Spatial Analyst Tools > Neighborhood > Focal Statistics
Input raster: PlotDEM
Output raster: FocalPlotDEM
Neighborhood: Circle
Neighborhood Settings Radius: length in map units
Neighborhood Settings Units: Map
Statistics type: Maximum
Ignore NoData in calculation: box flagged

STEP 9 Extraction of Focal Statistics values to Rill points
As said in Stp 7, the table of the shpfile ‘Rill_Elev_Points’ (see step

7) reports in the ‘grid code’ field the elevation value of rill cells. This
shpfile must be added by a new field containing the maximum value of
DEM found by Focal Statistics in the circle around each rill point.  This
operation is performed by using the command ‘Extracts values to
Point’.  
The resulting shpfile table contains, for each rill point,  a field with

the elevation value derived from DEM and another  field with the
Maximum elevation value found in the neighbouring circle.
If the extraction to points operation returns <null> values, export

the shpfile Rill_Elev_Points in a new shpfile and delete fields to the
right of the ‘pointid’ field. Then use this shpfile for all extractions.
Deleted fields can be joined at the end of extractions.

ArcToolbox: Spatial Analyst Tools > Extraction > Extract Values to
Points
Input Point Features: Rill_Elev_Points
Input raster: FocalPlotDEM
Output point features: RillPoints_Elev_Max
Interpolate values at the point locations: box not flagged
Append all the input raster attributes to the output point features: box

flagged

STEP 10: Mean rill excavation depth 
The shpfile RillPoints_Elev_Max is used to calculate the mean exca-

vation depth of rills. To do this, a new field named ‘Difference’ must be
added to its table.
The Attribute Table of this shpfile (Figure 17) shows in the field

named ‘grid_code’ the elevation of rill points, while in the field
‘RASTERVALU’ the maximum DEM value in the  circle surrounding
each point is shown (rill rim elevations). 
The newly created ‘Difference’ field is used to calculate the differ-

ence ‘RASTERVALU’ minus ‘grid_code’, which gives the rill excavation
depths at the point positions.

Action: Open the attribute table of the shpfile ‘RillPoints_Elev_Max’
Action: Add a numeric field (as double) named ‘Difference’ 
Action: Perform ‘Field Calculator’ over the ‘Difference’ field:

[RASTERVALUE] - [grid_code]
Result: Rill depth (map units) for each rill point 

STEP 11: Joining
Since Steps 8, 9 and 10 are repeated many times as the number of

radius chosen, at the end of analyses the results must be joined in a
unique shpfile.

Action: Open the Attribute Table of the shpfile ‘RillPoints_Elev_Max’
Action: Right click on Table Options 
Action: Joins and Relates > Join
Join Data dialog box - Choose the field in this Layer(...): Pointid
Join Data dialog box - Choose the table to join: (Tables in turn from
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Figure 14. Value 1 is assigned to rill cells (black), ‘Null’ (no data)
is assigned to no-rill cell (white).  

Figure 15. Resulting table from raster to point transformation.
The elevation of each rill cell is reported in the field named grid-
code.

Figure 16. Representation of rill cells converted into points (in
red).
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STEP10)
Join Data dialog box - Choose the field in the table to base the join on:

Pointid
Join Options:  Keep all records
Action: Save all the joins in a new shpfile ‘Joined_ Radii_Depths’

STEP 12: Adding curvature value to points
The curvature value determined in STEP 3 must be added to each rill

point. This value is necessary to perform a successive selection of
points based on this attribute.

ArcToolbox: Spatial Analyst Tools > Extraction > Extract Values to
Points
Input Point Features: ‘Joined_ Radii_Depths’
Input raster: PlCu_Plot (see STEP 3)
Output point features: ‘Joined_ Radii_Depths_PlCu’
Interpolate values at the point locations: box not flagged
Append all the input raster attributes to the output point features: box

flagged. At the end of STEPS 11 and 12 the resulting Attribute Table of
the shpfile ‘Joined_ Radii_Depths_PlCu’ will appear as represented in
Figure 18.

STEP 13: Selection of rill point depths according to plan curvature
values and radius of neighbouring circle
As already reported in the chapter on Focal Statistics, rill points must

be separated into groups according to different ranges of Plan curva-
tures values. For each group the user must calculate the statistics on
depths as calculated by FocalDiff analysis  by using the proper radius.  
The choice of ranges of Plan curvature was done by overlapping the

point shpfile ‘Joined_ Radii_Depths_PlCu’ on the orthophoto and by
selecting, in the layer properties, the PlanCurv field as graduated color
(with very large dataset it would be necessary to increase the Sample
Size in the ‘Data Sampling’ windows under ‘Classification’). In Figure
19  the result of this operation is shown.
In this exercise, 3 groups were considered: 

1)plan curvature values spanning -60 -26.436832. For these points, we
decided to consider the depths calculated by the 15 cm radius as the
most appropriate. In fact the rim is very close to these rill points (yel-
low group).

2)plan curvature values spanning -610 -125. For these points, placed in
the deepest position of large rills, we decided to consider the depths
calculated by the 30 cm radius as these points are the most distant
from the rill rims (magenta group).

3)plan curvature values spanning -125 -60, includes rill points in
between the two previous categories, so that we decided to consider
the depths calculated by the 25 cm radius (cyan group).

The selection of points according to Plan Curvature ranges was done
as follows:   
Each group of rill points belonging to the ranges of Plan curvature

values must be selected in turn from the Table, by using the following
commands: 
Open attribute Table of the shpfile ‘Joined_ Radii_Depths_PlCu’ >

Click Selection > Select By Attributes 
Method: Create a new selection
Type the desired SQL query into the selection windows, for three

times in turn according to the 3 different range values,.
In this exercise:
SQL query to select points for which 15cm is the proper radius size: 
‘ PlanCurv ‘ <= -26.436832 AND ‘ PlanCurv ‘ >-60 
SQL query to select points for which 25cm is the proper radius size: 
‘ PlanCurv ‘ > -125 AND ‘ PlanCurv ‘ <= -60
SQL query to select points for which 30cm is the proper radius size: 
‘ PlanCurv ‘ >= -609.033447 AND ‘ PlanCurv ‘ <= -125

STEP 14: Statistics of depth values of rill points selected by ranges
of Plan curvature values
After each selection performed by the SQL query, statistical parame-

ters of selected points must be calculated on the proper depth field of
the attribute table of the shpfile ‘Joined_ Radii_Depths_PlCu’.

                                Article

Figure 17. Attribute Table of the shpfile ‘RillPoints_Elev_Max’.
DEM elevations are reported in the field ‘grid code’. The field
‘Difference’ reports, for each rill point, the difference between
rim elevation (RASTERVASLUE field) and point elevation
(‘grid_code’ field).

Figure 18. The result shpfile ‘Joined_ Radii_Depths_PlCu’

Figure 19. Rill points grouped by plan curvature values.
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Example for selected points for which 15cm is the proper radius size: 
After point selection: Right-click  on the field ‘diff15’ of the Attribute

Table, then click on Statistics.  The statistical parameters ‘Count’  and
‘Mean’ of each group of points are used to calculate rill erosion in the
following step.

STEP 15: Rill erosion calculation 
To calculate total rill erosion (Table 6)  it is necessary to know the

bulk density of soil at UAV-survey time and the plot area.
In this example exercise the average bulk density, detected through

core method on field, resulted in 1.247 t/m3. The plot area is 1.5776 ha.
For each group of points the total area of DEM cells belonging to rills

is calculated by multiplying the counts (obtained from statistics) by the
pixel area. 
The volume of excavation for each selected group of points is calcu-

lated by multiplying the area by the mean depth of rill points.

Calculation for each group of rill points selected by ranges of Plan
curvature values:
Rill Area: Count (n. of rill points) * 0.04792(pixel area)= area m2

Rill Volume: area m2 * mean depth (m) = volume m3

Rill erosion: total of rill volume by groups (m3) * bulk density (1.247
t/m3) = tonnes
Specific Rill erosion: tonnes / ha (1.5776) = t/ha

EXERCISE N.2 (Fagna, Florence)
Lightly eroded field. Two diachronic DEMs analysed.

Site description
WGS84 Coordinates of plot centroid: N 43° 59’ 01.29’;  E 11° 21’

06.57’ (Mugello valley). 
Type: field plot 
Area: 1.1783 ha
Mean Slope: 14.4 % 
Maximum length along the slope gradient: 250.7 m
Geology: Pedogenized Pleistocene lacustrine deposits. 

Soil classification: Typic Udorthents (Soil Survey Staff, 2014), silty
clay texture (USDA, 2015). 
Grain size distribution: Total Sand 17.5%, Total Silt 42.0%, Clay

40.5%, O.M. 1.67 %.
Bulk density at UAV survey time: 1.222 t/ m3

UAV-Survey conditions and DEM resolution
Mean flying altitude (m): 49.97 
GCP spacing: on a square grid 40x40 m

Photomosaic resolution  (m/pix): 0.01132
DEM resolution (m/pix): 0.0572
UAV survey flight n.1 on  25/12/2013. DEM name: DEMdec13

UAV survey flight n.2 on  26/01/2014. DEM name: DEMjan14

In Figure 20 the orthomosaic of the study plot at second flight time
is reported. 
In Figure 21 a close up view of a downhill portion of the plot at first

flight date before soil erosion had occurred is shown. It is possible rec-
ognize the false rill incisions determined by cultivation tools. In Figure
22 the same piece of plot of Figure 21 after rilling is shown. False rills
are still present on the soil surface (Figure 23) and this justify the need
of the diachronic analysis of the two DEMs (before and after erosion
has occurred). 

STEPS 1 to 7 
Idem as in exercise n.1. Performed on both DEMdec13 and DEMjan14

STEP 7.1.: Selecting false rill points from the before-erosion DEM
It must be considered that not all rill cells detected on the  DEMdec13

are also present on the DEMjan14 .  Consequently, the analysis of false rill
depth for  DEMdec13  must be performed only for points which are also
present in 2014. 
The shpfile of rill points of January 2014 is used to extract the DEM

values of rill cells of December 2013. 
The raster of Rill cells of December 2013 (Rill_elev_dec13) is
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Figure 20. The 1.18 ha plot of the example exercise n. 2.

Table 6. Statistics of depth values for groups of rill points selected by ranges of Plan curvature values and Rill erosion results.

                                                                                                   Groups of rill points  by ranges of Plan curvature values
                                                                             Radius 15                                          Radius 25 cm                                            Radius 30 cm

From statistics
     Count (n. of rill points)                                                       660,994                                                                  346,468                                                                          97,265
     Mean depth of rills (m)                                                      0.02377                                                                 0.048325                                                                       0.031905
     Maximum depth of rills (m)                                             0.129295                                                                0.225693                                                                        0.24098
     Minimum depth of rills  (m)                                                   0                                                                       0.002625                                                                       0.001457
Calculations                                                                                                                                                                                                                                                              
     Area of rill cells (m2)                                                          1516.59                                                                    794.94                                                                           223.17
     Volume of rills (m3)                                                               36.05                                                                       38.42                                                                              7.12
Total volume (m3)                                                                                                                                                        81.59
Total rill erosion (t)                                                                                                                                                    101.74
Rill erosion by ha (t/ha)                                                                                                                                              64.49
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obtained by following the above STEP 6.
In the point shpfile resulting from extraction,  records with -9999

value in the field ‘RASTERVALUE’ of elevations December 2013 must be
removed. In fact, they correspond to rill points of Jan. 2014 which were
not present in December 2013 (Figure 24).

ArcToolbox: Spatial Analyst Tools > Extraction > Extract Values to
Points
Input Point Features: Rill_Elev_Points_jan14
Input raster: Rill_elev_dec13
Output point features: RillPoints_match_dec13jan14
Interpolate values at the point locations: box not flagged
Append all the input raster attributes to the output point features: box

flagged
Open the attribute table of the shpfile RillPoints_match_dec13jan14:

select and delete records with -9999 value in the field ‘RASTERVALUE’
of elevations December 2013.

STEPS 8 to 15
Idem as in exercise n.1. Performed on both DEMdec13 and DEMjan14

The only difference was the use of one radius length only of 10 cm
for both DEMs because it was sufficient according to the rill  width
(much smaller than in the plot at Tor Mancina, exercise 1).

STEP 11: Rill erosion calculation 
Subtraction: Rill volumes as detected for DEMjan14 minus false rill vol-

ume as detected for DEMdec13 .as shown in Table 7.
Done: Soil bulk density 1.222 t/m3; plot area 1.178ha; DEM’s cell size

0.05 m.

Interrill erosion evaluation
The proposed UAV-GIS methodology does not enable the measure-

ment of interrill erosion because this process does not determine inter-
rill surfaces affected by curvature. 
For the purpose of this paper the evaluation of the interrill portion of

soil erosion is made from the measured value of rill erosion by calcu-
lating the ratio of rill to interrill erosion (β), according to McCool et al.
(1989) who proposed  the equation for soils susceptible to rilling.

β=
11.16 sin�θ

0.56+3(sin�θ )0.8                                                                (eq. 4)

where � is the slope angle ( sexagesimal degrees). For soils that have
low or high susceptibility to rilling β is respectively halved or doubled.
Therefore, to determine the value of beta it is necessary to evaluate the
susceptibility to rilling. Susceptibility to rilling depends on a number of
factors such as the slope steepness, soil characteristics, management,
stoniness etc. In order to simplify, we assumed that  susceptibility to
rilling can be effectively described by the factor K erodibility factor of
RUSLE (Renard et al., 1997) or, more easily, by K of USLE (Wischmeier
e Smith; 1978) calculated through the equation (5), (valid  for soils
containing less than 70 percent silt and very fine sand).

K(USLE) = [(2.1M 1,14 (10-4)(12-a) + 3.25(b-2) + 2.5(c-3)] /100 (eq. 5)

where K (U.S. customary units); (M) is the percent silt (0.1-0.002 mm)
times the quantity 100 minus percent clay; (a) percent organic matter,
(b) is the soil-structure code used in soil classification (1= very fine
granular  <1 mm; 2 fine granular 1- 2 mm; 3=medium or coarse gran-
ular 2-10 mm; 4=blocky, platy, massive)  and  c  is the permeability class
(1=rapid >130 mm . h–1; 2=moderate to rapid  60-130 mm . h–1; 3=mod-
erate 20-60 mm . h–1; 4=moderate to slow 5-20 mm . h–1; 5=slow 1-5
mm . h–1; 6=very slow < 1 mm . h–1). When the value of permeability is
unknown it is recommended to use the class 4. 
The Soil Erosion Risk Assessment in Europe (Van der Knijff et al.,

2000) highlighted that erodibility of volcanic soils is very high and it
depends more on physical and chemical properties rather than texture.
For these soils the erodibility cannot be predicted by Equation (4) and
a value of 0.607 (US customary units) was assigned to all volcanic soils.
The calculated K factor  is used to evaluate  the class of susceptibility
to rilling from Table 8 and to decide whether to keep the same, halve or
double the ratio of rill to interrill erosion (β). This decision cannot
ignore the visual evaluation of the soil surface. For example, if the sus-
ceptibility to rilling resulted in the class ‘high’ but rills are scarce due
to rainfall scarcity, it is preferable not to change or even decrease the
value of β.

                                Article

Figure 21. Close up view of a downhill portion of the same plot
of Figure 19 at first flight time, before soil erosion has occurred.  

Figure 22. Close up view of the same portion of the same plot of
Figure 19 at the second flight time (after erosion had occurred,
one month after the previous UAV survey.  
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Exercise 3:  Interrill erosion calculation for plots of
exercises 1 and 2
Question
Evaluate interrill erosion occurred in the study Plots at Tor Mancina

and Fagna from soil particle size distribution, slope gradient %, by cal-
culating the ratio of rill to interrill erosion (β).

Tor Mancina data
Total Rill erosion as determined by UAV-GIS methodology in exercise

n.1= 64.49 t/ha
Slope gradient %= 15.4
total clay %= 30.7

fine sand %= 35.3
total silt %=30.0
OM%=1.61
structure code (SC) = 3
permeability class (PC) = 5
M= (%silt+%fine sand) (100-%clay) = 4525.3

Fagna data
Total Rill erosion as determined by UAV-GIS methodology in exercise

n.2= 16.08 t/ha
Slope gradient %= 14.4
total clay %= 40.5
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Figure 23. Close up view of the shadowed portion of the same
plot of Figure 19. In blue and red false and true rills have been
respectively found through planar curvature analysis.
Transparency was applied to true rills (red) to evidence the coin-
cidence of position with false rills (blue) in many locations.

Figure 24. Matching table of elevation of rill points. December
2013 (before erosion) and January 2014 (after erosion).

Table 7. Statistics of depth values for DEMdec13 and DEMjan14 and rill erosion results by difference.

                                                                    DEMdec13 false rills                      DEM rills                       Rills volumeminus false rills volume

From statistics:                                                                                                                                                                                                                           
     Count (n. of rill points)                                                     303,572                                              755,535                                                                         
     Mean depth of rills (m)                                                   0.013757                                            0.013817                                                                        
     Maximum depth of rills (m)                                            0.06604                                              0.06781                                                                         
     Minimum depth of rills  (m)                                           0.000595                                            0.000458                                                                        
Calculations:                                                                                                                                                                                                                                
     Area of rill cells (m2) (0.0025 m2 each)                         758.93                                               1888.84                                                                         
     Volume of rills (m3)                                                             10.44                                                  25.95                                                                       15.51
     Total Rill erosion (t)                                                                                                                                                                                                       18.95
     Rill erosion by ha (t/ha)                                                                                                                                                                                                 16.08

Table 8. Susceptibility of soil to rilling as determined though the classes of  K (soil erodibility). (classes of K available at:
http://www.iwr.msu.edu/rusle/kfactor.htm).

                           K erodibility classes and susceptibility to rilling                                                K (US units)
                                                                                                                                   (tons.acre.hr)/(hundreds.acre.ft.tonsf.in)

                                                                                   Low                                                                                                                  0.05 < 0.25
                                                                              Moderate                                                                                                               0.25 - 0.4
                                                                                   High                                                                                                                       > 0.4
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fine sand %= 15.1
total silt %=42.0
OM%=1.67
structure code (SC) = 3
permeability class (PC) = 3
M= (%silt+%fine sand) (100-%clay) = 3397.45

Solved (Tor Mancina plot) exercise
K(USLE) according to Wischmeyer and Smith, 1978 
(Microsoft Excel formula):
=((2.1*M^1.14)*(10^-4)*(12-OM%)+3.25*(SC-2)+2.5*(PC-

3))/100
Result: K= 0.403 (K=0.607  was adopted instead of the calculated

value, according to Van der Knijff et al., 2000 for volcanic soil of Italy) 
Result: Susceptibility to rilling (from table) = High

β(Microsoft Excel formula)4

=(11.16*ASIN(RADIANS((ATAN(slope%/100))*180/PI())))/((((ASI
N(RADIANS((ATAN(slope%/100))*180/PI())))^0.8)*3)+0.56)

Provisional Result: β=1.392
Result: βadjusted=1.392*2= 2.785

Interrill erosion= Rill erosion/2.785
Result interrill erosion= 64.49/2.785=23.15 t/ha
Total soil erosion 64.49+23.15=87,64 t/ha

Solved (Fagna plot) exercise
Result: K(USLE) = 0.037
Result: Susceptibility to rilling (from table) = Moderate
Provisional Result: β=1.340 (no adjustment is needed)
Interrill erosion= Rill erosion/1.340
Result interrill erosion= 16.08/1.340=12.0 t/ha
Total soil erosion 16.08+12.0=29.08 t/ha

Comparison between UAV-GIS and RUSLE-GIS
erosion 

Specific soil erosion (t/ha) rates for the Tor Mancina and Fagna
plots, as determined by applying the UAV-GIS methodology and the cal-
culus of interrill erosion  according to McCool et al. (1989), were com-
pared to the estimated values by applying the RUSLE model in GIS envi-
ronment. This exercise has been done in order to have a confirmation
of the validity of the new UAV-GIS methodology and consequently to
have an idea if the methodology can be used to calibrate RUSLE for the
uses of CAP.
As known,  DEM resolution influences greatly the  L and S factor of

RUSLE with consequent variation of the sediment transport ratio. L fac-
tor varies on the grid size and the steepness while S factor is influ-
enced only by steepness. Oliveira et al. (2013) report that the best sed-
iment production estimates were observed when DEM cell resolution
approaches 22.4 m, which is the length of standard plots used in the
derivation of the USLE model. For this reason, in this comparison exer-
cise, 20x20 m DEMs were used instead of the original high resolution
DEMs. 20-m DEMs were produced by resampling the original DEMs.
Another reason for using 20-m DEMs is that Italian Regions generally
adopt, for soil erosion estimates, the official 20 m resolution Digital

Elevation Model provided for by the Italian Ministry of Environment
(MATTM).
From Table 9 it is possible to argue that, for Tor Mancina plot, results

of RUSLE model and UAV-GIS methodology are quite well in accord. For
the Fagna plot, the results differ greatly from one another, even if it
both methods highlight the presence of  heavy erosion. From soil ero-
sion of 9 plots surveyed through the MO.NA.CO. project (Bazzoffi et al.,
2015) it was possible to compare soil erosion estimated by RUSLE with
the UAV-GIS measurements. 
Mean separation via the Duncan test (Table 10) shows that there is

no significant difference between the observed and predicted values
with the RUSLE model. Table 11 shows the regression summary.
Despite the few observations at our disposal the agreement between
RUSLE estimated erosion and the observed soil erosion through the
UAV-GIS methodology resulted quite satisfactory.

Discussion and conclusions

Soil erosion measurement through the UAV-GIS methodology inte-
grated by the calculus of interrill erosion appears suitable for the pur-
pose of evaluating the effectiveness of some soil conservation actions
adopted under CAP and a valid cost-effective compromise respect to
existing methods for measuring soil erosion on field through runoff
plots. In general, from calibration results it can be said that  the UAV-
GIS methodology can be used to detect rill depth, taking care to use the
appropriate radius length in the Focal statistics analysis. Moreover, the
acceptable comparison between observed erosion rates obtained
through the new methodology and RUSLE lead us to believe that the
new methodology can be applied. Nevertheless, there are some limita-
tions, some of them due to the UAV photogrammetry and other limita-
tions linked to some choices left to the user when using GIS, that are
able to greatly change the results. 
It is important to remember that there is no methodology to measure

erosion which can be considered as an absolute reference against
which all other methods have to compare. Even the method of measur-
ing with the runoff plots is not free from severe criticism (Hudson,
1993; Stroosnijder, 2005). For this reason it is difficult to find a term of
comparison to test the new methodology. Both of the above-mentioned
kinds of limitations of UAV-GIS methodology can be partly, but not total-
ly, overcome by: i) refinement of UAV survey through the improvement
of the camera or by using different sensor carried by drone; ii) correct
choice of sky conditions  for the execution of the flight, by giving pref-
erence to scattered light conditions; and iii) direct observation of the
soil surface before and after erosion has occurred in order to solve
some doubts that can arise when observing the orthophoto. Also an
increasing experience in UAV photo interpretation and repeated appli-
cation of the UAV-GIS methodology by different GIS expert can help
achieve of better results. 
In our experience the morphological definition of a rill is not a sim-

ple task. Also when working manually on the field, it is sometimes dif-
ficult to measure rill width. The edges of a rill can be very irregular, or
instead of having a U-shaped or V-shaped form they may have a modest
slope (especially the downstream rim), so it is difficult to define exactly
the limit between rill and interrill areas. In addition, when rill is large
without any parallel rims it is impossible, even by hand, to define the
cross section along which to measure rill depths.  The new methodolo-
gy simplifies these problems by finding, for each rill point, the differ-
ence between the elevation of the rill rim and the point elevation. 
The Plan curvature threshold  and the length of the radius of neigh-

bouring circle are crucial choices that can lead to very different results.
We found that the plan curvature threshold value, to delineate rills, is
not very difficult to decide. A good choice can be easily reached by

                                Article

4β(Microsoft Excel function in Italian): =(11.16*ARCSEN(RADIANTI((ARCTAN(slope%/100))*180/PI.
GRECO())))/((((ARCSEN(RADIANTI((ARCTAN(slope%/100))*180/PI.GRECO())))^0.8)*3)+0.56)
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observing graduated colours for different range quantities of curvature
values overlapped to the orthomosaic and to the hillshade of DEM (dif-
ferent hillshade layers, produced by changing illumination parameters,
can greatly help when choosing). For both of the analysed plots the plan
curvature value of -26.4368 was effective in detecting the rills. Thus, we
suggest to consider this value for DEM of about 5 cm cell size. The
radius length is the most crucial parameter especially for plots where
rill width varies very much from large to small. Because radius length
must be as small as possible to intercept the rill rim, it may be needed
to differentiate the length according to point position inside the rill.
Point position inside a rill can be defined by the associated value of
plan curvature. Another strategy can be that of dividing the plot into
sub-zones of prevailing rill widths and to perform separate analyses by
applying different radius lengths of neighbouring circles. Anyway the
user can identify the most appropriate approach of analysis, also com-
posite, according to the specific situation of the field studied.
The other problem that arises on feebly eroded agricultural soil is to

remove from the volume calculation of rill the part of volume deter-
mined by mechanical incision due to cultivation tools and machinery
that passes on the soil (false rills). When soil erosion is feeble, scour-
ing water deepens the existing mechanical incisions and rills erosion
cannot be attributed to the total volume of incision detected after ero-
sion has occurred. 
The second solved exercise is about a rilled plot in which the

diachronic analysis of DEMs was considered necessary to remove the
volume of false rills (mechanical incisions) which were still present on
the soil surface after soil erosion has occurred. As already mentioned
in the preface it would seem intuitive to measure rills volume by a sim-
ple diachronic  comparison of two DEM’s representing the same sur-
face respectively before and after soil erosion has occurred, on the
assumption that the elevation of the soil surface would change only due

to soil erosion. This assumption however is not always true and cannot
be easily verified because DEM modification can be determined also  by
post-tillage consolidation of soil, by mass movements, by soil deforma-
tion due to shrink-swell of clay minerals in relation to soil moisture
changes (Bronswijk, 1991; Brake et al., 2103). 
The solution adopted in exercise 2 to remove the false-rill effect is

also a compromise which may not be free from criticism. The weakest
aspect is the subjective judgement if mechanical incisions still play a
relevant role in determining the volume of rills after erosion has
occurred. This problem can be partly solved by direct observation of the
morphology of rills on the field. In the Fagna plot of exercise 2 this kind
of judgement was of crucial importance. In fact, the orthophoto of the
field after erosion, previously reported in the text, is able to show the
evident presence of residual mechanical incisions only to some extent.
The estimation of interrill erosion according to McCool et al. (1989)
has been reported  in the text but no further validation has been made. 
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